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Legal Notices

Novell, Inc., makes no representations or warranties with respect to the contents or use of this documentation, and 
specifically disclaims any express or implied warranties of merchantability or fitness for any particular purpose. 
Further, Novell, Inc., reserves the right to revise this publication and to make changes to its content, at any time, 
without obligation to notify any person or entity of such revisions or changes.

Further, Novell, Inc., makes no representations or warranties with respect to any software, and specifically disclaims 
any express or implied warranties of merchantability or fitness for any particular purpose. Further, Novell, Inc., 
reserves the right to make changes to any and all parts of Novell software, at any time, without any obligation to 
notify any person or entity of such changes.

Any products or technical information provided under this Agreement may be subject to U.S. export controls and the 
trade laws of other countries. You agree to comply with all export control regulations and to obtain any required 
licenses or classification to export, re-export or import deliverables. You agree not to export or re-export to entities on 
the current U.S. export exclusion lists or to any embargoed or terrorist countries as specified in the U.S. export laws. 
You agree to not use deliverables for prohibited nuclear, missile, or chemical biological weaponry end uses. See the 
Novell International Trade Services Web page (http://www.novell.com/info/exports/) for more information on 
exporting Novell software. Novell assumes no responsibility for your failure to obtain any necessary export 
approvals.

Copyright © 2007 Novell, Inc. All rights reserved. No part of this publication may be reproduced, photocopied, 
stored on a retrieval system, or transmitted without the express written consent of the publisher.

Novell, Inc., has intellectual property rights relating to technology embodied in the product that is described in this 
document. In particular, and without limitation, these intellectual property rights may include one or more of the U.S. 
patents listed on the Novell Legal Patents Web page (http://www.novell.com/company/legal/patents/) and one or 
more additional patents or pending patent applications in the U.S. and in other countries.

Novell, Inc.
404 Wyman Street, Suite 500
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U.S.A.
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Online Documentation: To access the latest online documentation for this and other Novell products, see 
the Novell Documentation Web page (http://www.novell.com/documentation).
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About This Guide

Novell® Open Workgroup Suite Small Business Edition is an all-inclusive solution that contains 
several industry-leading Novell products such as iFolder®, GroupWise®, iPrint, and eDirectoryTM. It 
also includes open source components for you to use as well. These components deliver the same 
functionality and stability as their retail counterparts without the overhead cost to you. The open 
source applications include a helpdesk system, antivirus services, and the OpenOffice Suite, as well 
as desktop faxing. 

Chapter 1, “Desktop Applications,” on page 9

Audience

This guide is intended for Novell Open Workgroup Suite Small Business Edition users.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation 
included with this product. Please use the User Comments feature at the bottom of each page of the 
online documentation, or go to www.novell.com/documentation/feedback.html and enter your 
comments there.

Documentation Updates

For the most recent version of the Novell Open Workgroup Suite Small Business Edition User Guide, 
visit the Novell Open Workgroup Suite Small Business Edition User Guide Web site (http://
www.novell.com/documentation/nows/).

Additional Documentation

For documentation on Novell Open Workgroup Suite Small Business Edition, see the Novell Open 
Workgroup Suite Small Business Edition Documentation site (http://www.novell.com/
documentation/nows/).

Documentation Conventions

In Novell documentation, a greater-than symbol (>) is used to separate actions within a step and 
items in a cross-reference path.

A trademark symbol (®, TM, etc.) denotes a Novell trademark. An asterisk (*) denotes a third-party 
trademark.
About This Guide 7
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1Desktop Applications

Novell® Open Workgroup Suite Small Business Edition is an all-inclusive solution that contains 
several industry-leading Novell products such as iFolder®, GroupWise®, iPrint, and eDirectoryTM. It 
also includes open source components for you to use as well. These components deliver the same 
functionality and stability as their retail counterparts without the overhead cost to you. The open 
source applications include a helpdesk system, antivirus services, and the OpenOffice Suite, as well 
as desktop faxing. 

These components are explained in detail in the following sections to assist you to meet your 
business needs. Client software applicable to each of these services is available in the Desktop 
Downloads section of the Novell Open Workgroup Suite Small Business Edition Web interface.

Section 1.1, “Personal File Backup (iFolder),” on page 9
Section 1.2, “OpenOffice,” on page 13
Section 1.3, “Collaboration Groupware and Messaging,” on page 14
Section 1.4, “HylaFAX,” on page 18
Section 1.5, “OpenVPN,” on page 21
Section 1.6, “Helpdesk,” on page 22

1.1  Personal File Backup (iFolder)
Novell iFolder allows your files to automatically follow you everywhere online, offline, all the time. 
It is a secure file storage solution that allows you to access your data from multiple workstations and 
locations. Your work environment now revolves around you, and your data is with you, wherever 
you are. You simply store your files in the iFolder directory on your workstation.

As you work, you can use iFolder to transparently synchronize changes through various 
workstations and network connections you might use. 

Section 1.1.1, “Key Features,” on page 9
Section 1.1.2, “Prerequisites,” on page 10
Section 1.1.3, “Logging In,” on page 11
Section 1.1.4, “Logging Out,” on page 11
Section 1.1.5, “Browsing Folders,” on page 12
Section 1.1.6, “Managing Folders and Files in iFolder,” on page 12

1.1.1  Key Features
“iFolder Client” on page 10
“File Synchronization and File Management” on page 10
“Shared Folders” on page 10
“iFolder Account” on page 10
“Synchronization Log” on page 10
Desktop Applications 9
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iFolder Client

An iFolder is a local directory that selectively shares and synchronizes files via a central computer 
with a user-specified group of users. The iFolder files are accessible to all iFolder members and can 
be changed by those with the rights to do so. 

The iFolder client integrates with your operating system to provide iFolder services in your native 
desktop environment. The iFolder client allows you to manage your own iFolders and to select 
which shared iFolders to set up on your computer.

For additional information on how to configure or install the iFolder Client, go to the iFolder Client 
Documentation Web site (http://www.novell.com/documentation/ifolder3/index.html?page=/
documentation/ifolder3/user/data/prerequisites.html) 

File Synchronization and File Management

When you set up an iFolder account, you can enable Remember Password so that iFolder can 
synchronize iFolder invitations and files in the background as you work.

You can configure the iFolder client to run automatically each time you log in to your computer’s 
desktop environment. The session runs in the background as you work with files in your local 
iFolders, tracking and logging any changes you make.

You can synchronize the files at specified intervals or on demand.

Shared Folders

You can access your iFolders across multiple workstations and share them with others.

You work with iFolders directly in your file manager or in the iFolders browser that is part of the 
client. Within the iFolder, you can set up any subdirectory structure that suits your personal or 
corporate work habits. The subdirectory structure is constant across all member iFolders. When you 
share an iFolder, member users with the Write right can modify the directory structure, and those 
changes apply to all copies of the iFolder. 

iFolder Account

You must configure at least one iFolder services account before you create iFolders. An iFolder 
session begins when you log in to an iFolder services account and ends when you log out, or when 
you exit the iFolder client. Your iFolders synchronize files with other active iFolders only when 
your session is active and you are working online. You can access data in your local iFolders at any 
time, whether you are logged in to the account or not.

Synchronization Log

The synchronization log displays a log of your iFolder background activity, such as uploading and 
downloading files for different iFolders.

1.1.2  Prerequisites
You need the following:

A connection to your network.
A supported browser (Mozilla* Firefox* 2.0, Microsoft* Internet Explorer 7.
 Workgroup Suite Small Business Edition User Guide
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The name of the server to which you will be connecting your iFolder client (see your 
administrator for this information).
A link to iFolder Web Access (see your administrator for this information).
You, or your system administrator, need to install the client on your computer from Novell 
Open Workgroup Suite Small Business Edition administrator Web page under Desktop 
Downloads.

1.1.3  Logging In
You log in to Novell iFolder 3.x Web Access to gain access to folders and files in any of your 
iFolders available to you in your Novell iFolder enterprise server account. This includes iFolders 
that you participate in but have not set up on a local computer. The enterprise server specified in the 
URL authenticates your username against the server’s LDAP directory services.

You can also specify which of the supported localized interfaces to use. This is typically the 
language code of the iFolder enterprise server. Make sure to configure your browser’s Languages 
setting to support the desired language. 

1 In a supported Web browser, enter the URL of the iFolder server where your iFolders reside. 
For example: http://servername.example.com.

2 In the left navigator of the welcome page, click iFolder 3.x to open the iFolder 3.x welcome 
page. 

3 In iFolder Links, click the link to Web Access to open the login page. 
4 On the iFolder 3.x Web Access Login page, specify the username and password for your 

account.
5 Use the Languages drop-down list to specify which language you want to use to access your 

files.
6 Click OK.

1.1.4  Logging Out
To log out, click the red square icon to the left of You are logged in as in the header area, then close 
your browser. If you do not log out, your session remains open until your session times out, which 
can be a security risk.

If the system connection times out when you are working in your iFolders, Web Access returns you 
to the log in again to resume working without closing your browser.
Desktop Applications 11
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1.1.5  Browsing Folders
The iFolders page lists all iFolders available to you in the current domain. Available iFolders include 
those you own and those that others have made available to you. You can access iFolders through 
Web Access even if you have not set up the iFolder on a local computer. To help you locate the 
iFolder you seek, the Owner column identifies the name of the person who owns the iFolder. Click 
the iFolder’s name to view a list of its folders and files, upload and download files, create folders, 
and delete folders and files.

1.1.6  Managing Folders and Files in iFolder
“Downloading a File” on page 12
“Creating a New Folder” on page 12
“Deleting Folders or Files” on page 12
“Uploading a File” on page 12
“Helpful Links” on page 13

Downloading a File

1 Click Open or Save.

NOTE: iFolder 3.x Web Access does not support uploading and downloading of 10 MB or larger 
files.

Open: Click Open to view the file's contents. You must have a compatible application on your 
computer to open the file. The file is downloaded to a temporary folder where Internet files are 
saved, such as Temporary Internet Files in Windows, and then opened with your local 
application. If you plan to work in the file, it is best to save the file locally, modify the file, and 
then upload it.
Save: Click Save to save the file locally or to a mapped drive. Navigate to the location where 
you want to place the file, then click Save. The file is downloaded to your computer.

Options on the page might differ slightly, depending on the Web browser you use.

Creating a New Folder

In the New Folder field, specify the name of the new folder, then click Create. Folder names are case 
sensitive. When the page refreshes, the folder appears alphabetically in the list.

Deleting Folders or Files

Select the check box next to one or more folders or files you want to delete, then click Delete. Click 
Confirm to confirm the deletion. 

Uploading a File

In the Upload File field, click Browse, locate a local folder you want to upload, then click Open > 
Upload. When the page refreshes, the file appears alphabetically in the list.
 Workgroup Suite Small Business Edition User Guide
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The maximum file size for the upload limit is configured by the administrator. By default, the limit 
is set to 10 MB; the limit for your server might differ.

Helpful Links

For troubleshooting, see the iFolder Documentation Web site (http://www.novell.com/
documentation/ifolder3/user/data/front.html).

1.2  OpenOffice
OpenOffice is a cross-platform suite of office applications including a word processor, presentation 
and spreadsheet applications, an HTML editor, and a drawing tool. This version of OpenOffice is 
extensively compatible with Microsoft Office, allowing you to better share files between platforms. 
It provides capabilities for creating, processing, reviewing, and revising the documents required in 
daily business.

OpenOffice also exports documents in Adobe* portable document format (PDF) and allows font 
matching when opening documents originally composed in Microsoft Office.

1.2.1  Starting OpenOffice
The OpenOffice Suite should be installed on your desktop.

You can access OpenOffice from the icon on your desktop or from the list of applications installed 
on your computer. When the file is open, you can begin writing your document, spreadsheet, or 
presentation.

OpenOffice Writer equivalent to Microsoft Word
OpenOffice Base equivalent to Microsoft Access
OpenOffice Impress equivalent to Microsoft PowerPoint*
OpenOffice Calc equivalent to Microsoft Excel*

1.2.2  Saving Files
OpenOffice is much the same as other office applications. To save a file, you click File > Save.
Desktop Applications 13
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OpenOffice saves files in the OpenDocument format by default unless you manually choose another 
option. If you find that you consistently need to save in another format, such as MSWord (.doc), 
you can change this default with the following procedure:

1 Click Tools > Options > Load/Save > General.

2 In the Default file format section, choose the Documentation type you will be working in, then 
choose the document format you want to use from the Always save as drop-down menu.

3 Click OK to save your changes. 

1.2.3  Sharing Files with Microsoft Office Users
With OpenOffice, you can simply save your documents in the Microsoft Office format so that 
Microsoft Office users can easily share documents.

1.2.4  Helpful Links
For further information on how to use the OpenOffice Suite, follow the link below:

http://documentation.openoffice.org/manuals/oooauthors2/0600MG-MigrationGuide.pdf

1.3  Collaboration Groupware and Messaging
Novell GroupWise is an enterprise collaboration system that provides secure e-mail, calendaring, 
scheduling, and instant messaging. GroupWise also includes task management, contact 
management, document management, and other productivity tools. GroupWise can be used on your 
desktop on Linux, Windows*, or Macintosh*; in a Web browser anywhere you have an Internet 
connection; and even on mobile devices.

Section 1.3.1, “Understanding Groupwise Item Types,” on page 15
Section 1.3.2, “GroupWise Icon Types,” on page 16
Section 1.3.3, “Sending Mail,” on page 17
 Workgroup Suite Small Business Edition User Guide
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Section 1.3.4, “GroupWise Messenger,” on page 18
Section 1.3.5, “HelpFul Links,” on page 18

1.3.1  Understanding Groupwise Item Types
“Starting the Groupwise Client” on page 15
“Getting Acquainted with the Groupwise Main Window” on page 15

Starting the Groupwise Client

The GroupWise should be installed on your desktop. To launch the client, click the GroupWise icon:

Getting Acquainted with the Groupwise Main Window

Your main work area in GroupWise is called the Main Window, where you can read your messages, 
schedule appointments, view your calendar, manage contacts, and more.

Nav Bar: Provides access to all commands and options that can be performed in GroupWise. 
Toolbar: Provides quick access to common tasks such as composing a new mail message.
Folder List: Shows the different objects and folders for your GroupWise account. Items listed 
here would include your cabinet of saved e-mails, trash, a sent items folder, and your calendar.
Panels: Shows you the contents of the item that you have selected. The default is e-mail 
messages. 
Desktop Applications 15
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Figure 1-1   GroupWise Work Area

1.3.2   GroupWise Icon Types
The icons that appear next to items in your mailbox, sent items folder, and the calendar show 
information about the items. The following table explains what each icon means.

Table 1-1   Icon Descriptions

 Icon   Description

Next to an item you have sent in Remote or Caching mode, this icon indicates that the item 
has been queued, but the queue has not been uploaded. After the item has been 
uploaded, this icon indicates that status information has not been received about the item 
being delivered to the destination post office or transferred to the Internet.

Next to the Sent Items folder, this icon indicates that there is at least one item that has 
been queued but the queue has not been uploaded.

Appears next to an item you have sent. If the item has been opened by at least one 
person, this icon appears until all recipients have 1) opened the mail, phone message, or 
reminder note; 2) accepted the appointment; or 3) completed the task.

Appears next to an item you have sent. The item couldn’t be delivered to the destination 
post office or it failed to transfer to the Internet.

Nav Bar Toolbar Folder list Panels
 Workgroup Suite Small Business Edition User Guide
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1.3.3  Sending Mail
A mail message has primary recipient, subject line, date, and can be carbon copied and blind copied 
to other users. You can also attach files, document references, sounds, movies and other objects to 
your mail messages.

1 Click New Mail on the toolbar.

Appears next to an item you have sent. Next to an appointment or task, this icon indicates 
that at least one person has declined or deleted the item. Next to a mail message, phone 
message, or reminder note, this icon indicates that at least one person has deleted the 
item without opening it.

One or more attachments are included with the item.

One or more sound annotations are included with the item, or the item is a voice mail 
message.

Draft item.

Appears next to an item you have sent.

Appears next to an item you have replied to.

Appears next to an item you have forwarded.

Posted item.

Unopened mail message with a low, standard, or high priority.

Unopened or opened appointment with a low, standard, or high priority.

Unopened or opened task with a low, standard, or high priority.

Unopened reminder note with a low, standard, or high priority.

Unopened phone message with a low, standard, or high priority.

An icon in your Calendar indicating that an alarm is set for the item.

 Icon   Description
Desktop Applications 17
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2 In the To field, type a user name, then press Enter. Repeat for additional users. If necessary, 
specify usernames in the CC and BC fields. 
or
To select usernames from a list, click Address on the toolbar, double-click each user, the click 
OK.

3 Type a subject for your message.
4 Type the text of your message
5 To include attachments, click the paper clip icon on the toolbar.
6 When you have completed your message and entered your addressees, click Send on the 

toolbar.

1.3.4  GroupWise Messenger
Novell GroupWise Messenger is corporate instant messaging product that uses eDirectory for its 
user database.

You can create a Contact List, send instant messages, create an archive of messages, allow and block 
others from seeing your availability, and more. 

Menu Bar: Used to send e-mails and to configure your Messenger.
Status Bar: Shows logged-in users and their status on Messenger.
Contact List: The listing of people in your list of contacts. It also shows a status of sent and 
received messages from each contact.
Action Menu: Enables you to quickly send messages, add contacts, etc.

1.3.5  HelpFul Links
GroupWise 7 User Guide (http://www.novell.com/documentation/gw7/gw7_userwin/index.html)

GroupWise Web Access FAQs (http://www.novell.com/documentation/gw7/gw7_userfaq/
index.html?page=/documentation/gw7/gw7_userfaq/data/bwx4645.html)

GroupWise FAQs for the Windows Client (http://www.novell.com/documentation/gw7/
gw7_userfaq/index.html?page=/documentation/gw7/gw7_userfaq/data/bwx44i2.html)

GroupWise FAQs for More Help (http://www.novell.com/documentation/gw7/gw7_userfaq/
index.html?page=/documentation/gw7/gw7_userfaq/data/a20gkue.html)  

1.4  HylaFAX
With the Novell Open Workgroup Suite, you have easy access to connect to a network printer.You 
can also send and receive faxes directly from your desktop.

Section 1.4.1, “Faxing HylaFAX,” on page 19
Section 1.4.2, “Helpful Links,” on page 20
 Workgroup Suite Small Business Edition User Guide
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1.4.1  Faxing HylaFAX
HylaFAX is an open source desktop faxing system that enables you to send and receive faxes 
without getting up and going to the fax machine.  It also provides you with the security and 
convenience of receiving faxes in a common location on your network.  This means no more lost 
faxes or sensitive faxes being delivered or seen by unauthorized personnel.

“Receiving a Fax” on page 19
“Sending a Fax” on page 19

Receiving a Fax

You need to set up HylaFAX to receive faxes:

The list of received faxes is the first screen you see when you open JHylaFAX to review received 
faxes.

1 Go to Settings and specify connection configuration settings. The port number is 
preconfigured.

Host: IP address of your Novell Open Workgroup Suite Small Business Edition server.
Port: Preconfigured port number.
Username: Used to log in to the server.

2 Click Next.
3 Specify sender and notification settings.

Name: Specify your first and last name. This is used to identify you to fax recipients.
E-Mail: Address to receive notification when a fax has been sent or cancelled.

4 Click Next.
5 Configure external viewer programs to display received and sent faxes. Specify the path of a 

program.  
or
For HylaFAX to populate a list of all PDF files, click Search and specify $f. For example, xpdf 
~/$f.pdf. $f is a placeholder for the path of the PDF file that the program displays.

Fax Viewer: Path of a program that can handle TIFF G3 files.
Document Viewer: Path of a program that can handle PostScript* files.

6 Click Finish to complete your JHylaFAX configuration.

Sending a Fax

1 To use JHylaFAX run the following command at the Linux command prompt: java -jar 
jhylafax-1.3.10-app.jar.  

To launch JHylaFAX in OS X or Windows click the icon on your desktop. 

The following directions are applicable to Linux, OS X, and Windows.
Desktop Applications 19
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2 Click File > Send Fax.

3 Specify the phone number, then click the folder icon to select a document to send.

4 To send a fax, click OK.

1.4.2  Helpful Links
JHylaFAX Manual (http://jhylafax.sourceforge.net/manual.html)

JHylaFAX Client Information (http://jhylafax.sourceforge.net/)

HylaFAX Server Documentation  (http://www.hylafax.org/content/Documentation)
 Workgroup Suite Small Business Edition User Guide
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1.5  OpenVPN
Section 1.5.1, “Launch OpenVPN,” on page 21

1.5.1  Launch OpenVPN
1 Click the OpenVPN icon.

2 Click Use OpenVPN Config-file Settings, then click OK.
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3 You are now connected to OpenVPN. To disconnect from OpenVPN, click Disconnect.  

1.6  Helpdesk
Helpdesk provides an online resource for you to report problems, check the status of your submitted 
Helpdesk tickets, and research previously submitted tickets. Helpdesk gives you the reassurance that 
your incident has been received, and allows you to track the progress of your incidents.

Section 1.6.1, “Logging In,” on page 22
Section 1.6.2, “Submitting Incidents,” on page 22
Section 1.6.3, “Helpful Links,” on page 23

1.6.1  Logging In
To log into the Helpdesk application, you must first have an account created in eDirectory. Contact 
your system administrator to verify this access.

1 Go to the Helpdesk Web site that has been specified by your system administrator.  Specify 
your username and password in the space provided.  Your Helpdesk username and password is 
the same as your eDirectory username and password.

2 Click Login to access your Helpdesk page. After you log in, the you are directed to the Add 
Incident page.

1.6.2  Submitting Incidents
A Helpdesk ticket can be submitted for a wide range of work-related problems you might encounter. 
The ticket is an efficient way for you to notify your business of your problem.

1 To begin reporting an incident, click Add.
 Workgroup Suite Small Business Edition User Guide
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2 In the Problem field, specify a description of your error. Be sure to write a detailed and accurate 
description of the problem to allow for a speedier solution to be provided.

3 In the Queue field, select the appropriate category for your problem:
General: Miscellaneous problems. Port connectivity issues.
Network: Problems pertaining to account setup on the server.
Server: Problems pertaining to account setup on the server.
Workstation: Problems pertaining to your issued laptop or desktop.

4 In the Priority field, select the appropriate rank for your problem:
Fatal: Lost capability to critical systems.
Critical: Lost capability to non-critical systems.
Urgent: Important conflict not pertaining to work.
High: Concerns relating to items needed for productivity.
Medium: Concerns relating to access needed.
Low: Nice to have, but not needed to accomplish tasks. 
Informational: A communication that does not need any action, such as Account 
deactivation.

5 If applicable, click Browse in the Attachment field and insert an attachment, such as a screen 
shot of the error message you received, or a log file.

6 Click Open Incident to submit Helpdesk ticket.

1.6.3  Helpful Links
For further user information see the Helpdesk User Guide Web site (http://www.novell.com/
documentation/beta/nows/pdfdoc/nows_helpdesk_user_guide/nows_helpdesk_user_guide.pdf)
Desktop Applications 23
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